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When you select the tab and open QC Console, all
documents in the group or view are displayed.
•

Apply Settings to Multiple Document Type Groups
– When choosing the correct settings with which to
process your documents, you can now apply the
settings to multiple document type groups at the
same time.

•

Password Cracking for Microsoft Excel Worksheets
– During processing of a Microsoft Excel workbook we
will automatically attempt to remove the worksheet
protection, including password protection, at the
worksheet level if you have selected the Remove
worksheet level protection option in the Excel
render settings (under Worksheet options). By
selecting this option we will utilize a brute force
functionality that will iterate through up to 196,000
times to attempt to crack the password on the
worksheet.

New Features of Discovery Cracker
Version 5.4.0
•

Searchable PDF – We are pleased to announce that
you now have the option to render documents to the
searchable PDF format.
At this time, Discovery Cracker does not provide the
ability to produce a searchable PDF from a
nonsearchable document such as an image file or a
nonsearchable PDF.
In addition, PDF source files will not be rendered to a
PDF format; they will simply be copied to the
appropriate folder during processing. This creates a
limitation regarding the ability to change the
attributes of a source PDF file. For example, you will
not be able to take a color PDF and make it black and
white, nor will you be able to change the DPI.

•

•

Monitor Workflow Manager Activity – In past
versions of Discovery Cracker you had to go to the
Workflow Manager computer to see what was
happening on your DC Engines. Or you could go to
each DC Engine computer and see what was going on.
Now, from Discovery Cracker Console you can see
what item is being processed by which DC Engine.
Open Discovery Cracker Console. On the menu bar
select Tools, then select Monitor Workflow Manager
Activity. You can choose to display a snapshot of
documents being processed per DC Engine computer
or per job. You can manually refresh the snapshot or
select to have the snapshot refreshed automatically at
regular intervals.
QC Console is Available at the Job Level – With
Discovery Cracker 5.4.0 when you select a job in the
navigation pane, the QC Console tab is available.
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Please note that this can make processing of
Microsoft Excel spreadsheets take longer than
expected if you have quite a few that are worksheet
password protected. However, on those Microsoft
Excel documents that do not have a password
protection at the worksheet level, the processing will
not be impeded by this process.
•

Import Keywords into a View – You can now import
a list of keywords into a view when using the Is In or
Is Not In operators. This operator is not available for
all fields. Additional functionality will be added to
Discovery Cracker in future releases to work with the
other operators. To use this feature, you must first
create a .txt file containing a single list of values, with
each value on a separate line.

•

Field Selection During Export – In previous versions
of Discovery Cracker you could only choose a field
once during an export. You can now select the same
field multiple times. This is helpful if you need a
different formatting for a particular field or if you
need the same data represented in a field with two
different names, such as for the date and time.

•

Manual Printing – You can now manually print
documents to TIFF and text or to PDF with only
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Discovery Cracker Console installed on your
computer.
•

Adobe Acrobat 9 support – Discovery Cracker now
supports the use of Adobe Acrobat 9. You may use
Adobe Acrobat version 7, 8, and 9. We have removed
the support for using Adobe Acrobat version 6. Please
note that Discovery Cracker requires that you install
either the Standard or Professional editions of Adobe
Acrobat. Discovery Cracker does not work with
Adobe Acrobat Reader.

Upgrade Instructions and Notes
For customers currently using Discovery Cracker 5.3.1:
1.

Close all programs and all Discovery Cracker
components on all Discovery Cracker 5
computers.

2.

Restart all Discovery Cracker computers before
upgrading.

3.

Run Discovery Cracker Update 5.4.0.x.exe on
each computer in the following order:
a. Workflow Manager computer
b. DC Engine computer
c. Discovery Cracker Console computer
d. DC Detective computer

4.

After completing the upgrade, restart your
computers.

It is important to perform the upgrade on ALL of your
computers before attempting to start the individual
components.
If you are using a series 5 version of the software, but not
the 5.3.1 version, please contact Discovery Cracker
Product Support for assistance in obtaining the necessary
updates.
Upgrading and Enhancements – On upgrade to 5.3 and
subsequently to 5.3.1 some new enhancement upgrades
could not be automated. These two enhancements are
the Save Errors for the project error database table and
the ability to turn off the indexing that is done during
processing. If you have been upgrading Discovery Cracker
from prior to 5.3, please contact Product Support for
assistance in updating your program to be able to use
these two functions.
Upgrading with SQL Server Express – SQL Server Express
has a 4 gigabyte per database limitation. If you have been
using this version of SQL Server and you have a project
database that is close to or exceeds this limitation, you
will have difficulty upgrading Discovery Cracker. Please
contact Product Support for assistance.

Contact Us
Please feel free to contact us with any comments or
questions you may have.
Our business office hours are 8 a.m. to 5 p.m. Eastern
time, Monday through Friday.
Hours for Discovery Cracker Product Support are 8 a.m. to
7 p.m. Eastern time, Monday through Friday.

Mailing
Address
Phone
Fax
Web Site

Phone
E-mail
Phone
E-mail

Office
1180 Celebration Blvd., Suite 104
Celebration, FL 34747-4950
407-566-4300
407-566-4301
http://www.discoverycracker.com
Product Support
866-833-5377
dcsupport@wolterskluwer.com
Updates and Information
407-566-4268
info@discoverycracker.com

Important Instructions Not Provided
Elsewhere
Following are topics that were not ready in time to include
in the Discovery Cracker Environment Setup and Installation
Guide or User Guide for version 5.4:
WinZip 12 instructions – If you use WinZip 12 as your
archive application, when you process archived
(compressed) files, Windows Explorer will remain open
during processing.
To prevent this from happening, you need to perform the
following steps on each DC Engine computer on which
WinZip 12 is installed.
1.
2.
3.

Create a test zip file.
Open the file in WinZip.
On the Options menu, make sure that Save
Settings on Exit is checked.
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4.

Select the Extract icon.

Software Constraints
As with any software, Discovery Cracker has limitations
that should be noted for the awareness of our customers.
Most of these limitations have already been noted in the
User Guide. However, listed below are limitations that are
not otherwise noted.
These limitations are:

5.

In the Extract dialog box, clear the Open
Explorer window check box.

Microsoft Office Project 2007 – Files created with
Microsoft Office Project 2007 are not yet supported.
Exports – When running exports you can only run one
type of export at a time in a given project. However, you
can run multiple exports of different types simultaneously.
Working from a Mapped Drive – Discovery Cracker does
not allow you to work from a mapped drive. Everything
must be accessible using a UNC path, including files used
for the import feature.
Job Scheduling – If you create a job to run following the
completion of another job within the same project and
group, but the second job depends on the first job for
count of items, the second job may not perform the
requested action on all items.

6.

Select Extract.

PDF Render Settings – PDF render settings do not include
the Page size setting or the Orientation setting, as
indicated on pages 231 and 233 of the User Guide.
You control orientation and page size settings for
rendering to TIFF and PDF from settings available on the
User-Selected Application tab. To find those settings,
you can search for the keywords “orientation” and “page
size” in Appendix A, “Task Settings,” of the User Guide.

Documentation
The following documents are installed in the
Documentation folder in the Discovery Cracker program
folder. You can access them from the Start menu:
Start>Programs or All Programs>Discovery
Cracker>Documentation.
• Environment Setup and Installation Guide for
Discovery Cracker 5.4
• Field List for Discovery Cracker 5.4
• Readme for Discovery Cracker 5.4.0
• Supported File Types for Discovery Cracker 5.4
• User Guide for DC Detective 5.4
• User Guide for Discovery Cracker 5.4

For example, if you create a group to process data in a
folder and then create a job to perform the first three
actions (Initial Spin Through, File Spin Through, and
Extract Metadata) on that group, and immediately create
a job to perform the Render action and have the second
job follow the first, the job for Render will run after the
first job as requested, but because there were no items for
it to perform the action on at the time it was created, no
documents are rendered.
Processing Microsoft Access Databases - Internal
metadata is not collected on Microsoft Access files.
Because of limitations with the handling of Access files, we
are unable to extract much of the internal metadata;
however, we extract the body text (table information)
from the databases.
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Issues Resolved From Previous Releases
The following issues from previous versions of the Discovery Cracker program have been resolved. You no longer need to use
the previously described workarounds.
Affected Process
DC Detective

DC Detective
Endorsing

Exports

Exports

Exports

Exports

Description

Comment

If you remove access to all projects in a DC
Detective access role, the user assigned this
role still has access to all projects after
logging into DC Detective.
When using the advanced search function,
Clear Search is not working properly.
The font size chosen during endorsement of
the TIFF images is not being saved.
Discovery Cracker will endorse everything
using an 8.25 font.
The time stamp in the Data Ddelimited
Text File Export and CT Summation DII
Export changes depending on which time
zone the DC Engine computer that is
performing the export job is set to.
Within the Ringtail Export if you import
saved fields, they are not being saved to the
list of fields to populate in the export_extras
table.
When exporting to a Ringtail database, if the
data contains a large body field, an error
message (“Query too complex") occurs at
the job level and the export fails.
When using custom fields on Class 2 and
Class 3 of the CT Summation DII Export,
the @C token is not present for any record
that does not have a value in Discovery
Cracker’s database.

This issue has been resolved.

Issue
Number
10162

This issue has been resolved.

11659

This issue has been resolved.

11228

This issue has been resolved.

11711

This issue has been resolved.

11742

This issue has been resolved.

11755

This issue has been resolved.

11773

This causes a problem in the iBlaze,
Enterprise, and CaseVantage applications
because they are designed to inherit the
value for any @C token into the next record
unless a "change value" @C token is put into
the current record.
For example, take the field "Importance". If
you choose to add this as a custom field and
if email record 1 contains a value of "@C
Importance High" but for email record 2
there is nothing available, your export will
not contain an "@C Importance" token in
email record 2. When you import this file
into any of the three aforementioned

Now anytime you select a
custom field, this token will
appear on every record. If
the record does not have a
value for the token, it will be
blank to reset the token
during your import into the
CT Summation products.
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Affected Process

Exports

Job Scheduling

Postprocessing

Processing

Processing

Description
applications, the "@C Importance High"
value from email record 1 will be inherited
into email record 2 and onward until
another "@C Importance" token is seen in
the DII.
When selecting one volume to export out of
many volume sessions with the same prefix,
you get the following error message: "Failed
to enable constraints. One or more rows
contain values violating non-null, unique, or
foreign-key constraints."
If you create a job to run following the
completion of another job within the same
project and later decide to run the job
immediately, the changes are not being
properly saved and the job will never run.
The job continues to show a status of
Scheduled in the navigation pane and the
Jobs tab.
When setting up your Bates number session,
if you do not provide enough numbering
digits for your data set, the postprocessing
job will go into a paused state immediately.

When using the deduplication functionality,
some attachments are getting rendered
even though they are duplicates of
previously processed documents.
If your database is SQL Server 2005
Enterprise Edition and reindexing starts
while the Initial Spin Through action is
being performed on a large container item
(Folder, PST, NSF), all the existing items are
deleted from the Items table and Initial
Spin Through starts over again.

Comment

Issue
Number

This issue has been resolved

11785

This issue has been resolved.

10492

This issue has been resolved.

11453

While your job will still go
into a paused state, the Jobs
tab will now show you why
this has occurred.
For Page Number Digits,
we have updated the default
number of digits to 6, which
should prevent most of the
problems. However, when
setting Document Number
Digits, Child Number
Digits, and Page Number
Digits, you must be sure to
provide enough digits for the
data set you will be
processing.
This issue has been resolved.

You can now control
whether or not to allow
indexing to occur and set the
timer for indexing to a
higher value to prevent this
from happening. Please
contact Product Support for
assistance.

10245

11055
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Affected Process
Processing

Processing

Processing

Processing
Processing

Rendering

Settings

Status

User Interface

Description

Comment

PDF files created by some tools, such as
Ghostwriter, do not allow Discovery Cracker
to extract the Body field.
When processing Lotus Notes files, the time
zone (which is passed during processing for
the purposes of updating the image files) is
set on the DC Engine computer. If the DC
Engine crashes, in some instances the time
zone from the project information is left as
the setting on the DC Engine computer.

This issue has been resolved.

Issue
Number
11416

This issue has been resolved.

11445

This issue has been resolved.

11489

This issue has been resolved

11728

This issue has been resolved.

11852

This issue has been resolved.

11465

This issue has been resolved.

10453

This issue has been resolved.

11332

This happens when the file
server is not on the same
workgroup or domain as the
Discovery Cracker
components.

10115

This can cause problems with single-box
users who have their SQL Server on the
same computer as their DC Engine. The SQL
Server’s time may be affected.
After a long period of processing, Microsoft
Word begins to throw errors that Word has
run out of memory.
When processing EML files, the CC, BCC,
and SentTo fields are not being populated.
Discovery Cracker cannot process read-only
files, including NSF and PST files.

Charts for some Microsoft Excel
spreadsheets are not properly rendered.
While the data is rendered correctly, the
chart itself is not rendered.
If you change folder settings and then cancel
out of the Folder Settings dialog box, the
changes you made are saved.
When deduplication is enabled in a project
and set to deactivate the items found to be
duplicates, only the main item has the
status of Inactive – Duplicate. The child
items have the status of the last processed
action, such as Extract Metadata or Render.
You cannot choose a file server that does
not appear in the My Network Places\Entire
Network\Microsoft Windows Network of
Windows Explorer.

There is a method that can
be used to bypass this
behavior, but it is provided
on a case by case basis.
Please contact Product
Support if you need further
information on how to do
this.
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Affected Process
Views

Views

Description

Comment

If you create a view and choose multiple
fields before selecting the operator and
criteria, only the first field alphabetically will
be added to the view statement.
When creating a view that contains criteria
that exceed 4,000 characters, the view
generates an error.

This issue has been resolved.

Issue
Number
10432

This issue has been resolved.

11376

Known Issues and Workarounds
The following issues are known to exist within the current version of the software. If applicable, a workaround has been
provided to help you avoid any problems. Please read through these issues carefully before processing.
Affected Process
Exports

Exports

Exports

Exports

Exports

Exports

Description
Using the folder structure naming option in
the Ringtail export may cause duplicate
document IDs which will prevent the export
from being successfully created.
When using the CT Summation DII exports,
the option to monitor the DII file size is set
to 0 by default. If you select this option and
do not set an appropriate limit, you will get
a blank DII file.
Intermittently, the CT Summation DII Class
2 export duplicates records for a PST job.
The CT Summation DII Class 2 & Class 3
default fields include the @Storeid field;
however, intermittently this field is not
included in the resulting DII output.
When using the Data Delimited Text File
Export and you select a session from the
drop-down box, the Documents to Process
area doesn't match the Before
Postprocessing or After Postprocessing
selection for the session. It displays
whatever the previously selected session
was.
When using the DocuLex 5 Export the
following error is generated when a data set
exceeds the limitations of the output
format:
Exception of type
'System.OutOfMemoryException' was
thrown.

Workaround
Order the documents by
Original File Path prior to
Bates numbering them.

Issue
Number
10288

Set your DII maximum file
size to the desired limit
when using this option.

11241

If you see this occur, please
contact Product Support
immediately.
No known workaround at
this time.

11309

11386

Select the settings you need
for the session and then
select Update Session.

11395

The DocuLex 5 Export is a
FoxPro format which has
several limitations. Please
keep your data set within
the bounds of these
limitations. For further
information on these
limitations, please review
the following:
http://fox.wikis.com/wc.dll?

11435
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Affected Process

Description

Exports

The EDRM XML export fails when the Body
field contains certain invalid characters. The
characters are hexadecimal value 0x1B.

Exports

When working with the Ringtail Export, if
the field value of the Discovery Cracker
metadata exceeds the output value in the
Ringtail database, the data will not be
populated.

Folders

If you select the option to create a folder
and do not provide a name for the folder,
New Folder will be provided for the name.
However, if you select the refresh button
before adding a project to the folder, New
Folder will be removed from the Discovery
Cracker Console navigation panel.
If you import job settings from another
project for a CT Summation DII Export job,
the save location is from the other project,
not the one you are in. In one circumstance
this had a truncation problem on the relative
pathing option due to the difference in size
of the Volumes path from a different
project.
If you mark an item that has been OCR’d to
re-OCR and disable the OCR option for that
document type group, the data in the All
Text field is not deleted.
If you select to render documents with the
OCR option turned off and then select to
rerender the documents with the OCR
option turned on, most of the items do not
complete and an error message is received:
"Deleted row information cannot be
accessed through the row."
The endorsement functionality is not
currently working during paper printing.

Import Job
Settings

OCR

OCR

Paper Printing

Postprocessing

After creating a Bates number session and
then selecting it, you are allowed to change
some of the settings; but these changes are

Workaround
Wiki~VisualFoxProLimits~VF
P
Recrack the document. On
the Get Body Text tab of
the Extract Metadata
action, clear the Extract
body text check box.
Whenever possible use the
Split Values option in the
Field Selector dialog box
(when you select Select
Fields on the Party Table
tab or the Extra Table tab).
Provide a name for the
folder as you create it.

Issue
Number

11495

11676

10444

After performing the import
job settings, be sure to
update the file path
information for the export
locations.

11831

You can recrack and
rerender documents to clear
the All Text field.

11248

If you need OCR data and
you have images, select the
Redo OCR option rather
than the Rerender option
while in QC.

11889

If you need to print
endorsed TIFF images,
endorse them during
postprocessing, then print
the TIFF images to paper.
See chapter 14, “Endorsing
Documents,” on page 162 of
the User Guide for Discovery
Cracker 5.2
If you find that you have set
something incorrectly while
creating a Bates number

10530

10456
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Affected Process

Description
not saved.

Postprocessing

Postprocessing

Postprocessing

Postprocessing

Processing

When creating a Bates number session, if
you select a field to sort the records by, save
the changes and then go back into the Sort
Field Selector dialog box and select another
field to add to the existing field selection,
the previous selection is removed.
When creating jobs for postprocessing,
Discovery Cracker allows you to create
multiple jobs within the same project, but if
the jobs are run at the same time, only the
job that gets to the Workflow Manager first
is able to run through completion. Any
subsequent job goes into a not created state
and can never be run. Even pausing and
restarting the job does not solve the
problem.
The Bates number padding for the document
counter is not retained when the Include
Bates number prefix in the file name
option is cleared (when creating a volume
session).
For example, if you set the Document
Number Digits to 4 and the Page Number
Digits to 6 (when creating a Bates number
session) and then you process 10
documents, each resulting TIFF image
should have a name something like
0001.000001 or 0010.000003. Instead, the
padding is removed from the document
number digits and the resulting TIFF image
has a name like 01.000001.
When selecting to include the native files
during the packaging stage of
Postprocessing, Access databases sometimes
result with a copy in the volume folder that
will generate a different MD5Hash value
when run back through processing.
During processing, some applications, such
as Microsoft Word, must be opened in a
visible manner in order to work properly. The
documents that are processed using these
applications are opened during processing;
however, when processing is complete for
the individual documents, the last document
processed remains open in the application
window.

Workaround
session, you need to create a
new session to adjust your
settings.
When choosing your sort
fields, select or re-select all
of the fields you wish to sort
your records by before
exiting the Sort Field
Selector dialog box.
Do not create multiple
postprocessing jobs within
the same project.

No known workaround at
this time.

Issue
Number

10481

10487

11502

This only applies when you
include Document Number
Digits in your Bates
numbering scheme.

No known workaround at
this time.

11847

While the applications used
during processing will
remain open, the last
document being processed
will be closed so you will
only see an empty
application window.

10217

At this time the only
exception to this update is

9

CT Summation Discovery Cracker | Readme 5.4.0

Affected Process

Description

Workaround

Issue
Number

Lotus Notes, which still
remains open with the last
NSF file open as well.

Processing

The English currency symbol (the pound sign
[£]) is converted to a question mark [?] when
rendering .msg files, but the same character
is not converted when it is found in
Microsoft Office documents.

Processing

If the LastModifiedDate value is invalid,
Discovery Cracker is unable to process the
file.
When processing Chinese documents, the
text file produced is missing blank lines. The
Body field does not contain any line breaks
and is missing any underlined words.
If an archive file contains files with foreign
language characters in the file name, the
Body field is not collected correctly.
During the course of processing, temporary
files are stored in the local temp folder. On
occasion, these files are not removed at the
end of processing.

Processing

Processing

Processing

Processing

If you select a specific user.id file and
password to use for Lotus Notes NSF
processing, you may receive an error during
processing: "One or more certificates in your
Notes id have expired".

Processing

Discovery Cracker recognizes Microsoft
Snapshot documents as Microsoft Cabinet
document type.

The applications are being
left open to limit the
overhead of reopening when
the next job is assigned to
the DC Engine for
processing.
This has been partially
resolved with this version,
but there is an additional
character that is being added
(Ẫ) in front of the pound
symbol.
No known workaround at
this time.

10237

10410

No known workaround at
this time.

11098

No known workaround at
this time.

11162

It is recommended to
periodically clear out the
temp folders used by
Discovery Cracker. Please
contact Product Support for
assistance.
This issue has been resolved
by using a Click Robot entry.
However, there is now a
security dialog box that
cannot be handled by Click
Robot. You will need to
respond to this security
dialog box by selecting the
option “Start Trusting this
signer” in order to continue
processing the NSF.
Use the file extension
override function (Override
Document Types) in the
Manage File Extensions
dialog box to control which
document type group is
assigned these documents.
See “Managing File

11186

11234

11372
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Affected Process

Processing

Processing

Processing

Processing

Processing
Processing

Processing

Processing

Processing

Project Creation

Description

When processing TIFF images, Discovery
Cracker puts data in the Body field that
should not be there, for example
"//DOXPrinter012007:01:08 16:47:20"
When Outlook emails have MSG files
attached and the attached MSG files have
Unicode characters in the file name,
underscores replace the Unicode characters
in the file name.
When an MSG file is embedded into another
file and the embedded file has Unicode
characters in the file name, the file name is
not collected correctly. In addition, the TIFF
and text file displays the wrong Subject line.
When processing multiple jobs, sometimes
DC Engine computers sit idle and are not
used. This happens when doing exports and
Workflow Manager picks up more than one
export job.
When processing a .#1 file type, the first two
lines of data are missing from the Body field.
When processing EML files, the Attachment
Counts field is not correctly populated.
However, the correct number of
attachments is extracted.
When processing EML files, the date/time
fields populated in the database are 1 hour
behind the original email.
When rendering Excel files with the Custom
Page option of page size Legal, the rendered
image orientation is opposite of what is
chosen for this setting.
Using the (GMT) Casablanca time zone
errors the whole set of data in a project if
selected at the project level.
The error message associated when the time
zone is selected is: "SqlDateTime overflow.
Must be between 1/1/1753 12:00:00 AM and
12/31/9999 11:59:59 PM."
When creating a project, if you select the
Enable Filtering check box and then clear it,
the check box is permanently disabled.

Workaround
Extensions” on page 43 of
the User Guide for Discovery
Cracker 5.2.
No known workaround at
this time.

Issue
Number

11373

No known workaround at
this time.

11466

No known workaround at
this time.

11467

No known workaround at
this time.

11494

No known workaround at
this time.
No known workaround at
this time.

11535
11607

No known workaround at
this time.

11743

If you need to render Excel
to a Legal size page and need
to change the orientation,
select the orientation
opposite of what you need.
Use one of the other GMT
time zones.

11872

If this occurs and you need
to enable filtering on your
project, cancel out of the
current project creation
dialog box and create a new
project.

11896

10501
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Affected Process

Description

Workaround

Project Creation

If a project filter is created with the option
"Consider family relationships. Examine all
documents..." and an attachment meets the
criteria, the item that meets the criteria will
loop indefintiely.

QC

If a rendered color TIFF image has LZW
compression, you will receive an error in QC
Console when you attempt to view the
image using the image viewer. The error
message is: "File may be locked by system or
does not exist. LEAD error: The LZW
capabilities are locked".

QC

If you use the Advanced Search feature in
QC Console, the Clear button at the bottom
of the Advanced Search panel does not
clear the panel from displaying the last
criteria you searched for.

QC

QC Sessions are not being closed out when
multiple people are in the same session.

QC

If you attempt to select multiple records and
one of the records that are included in your
selection group is locked by another process,
only the first or the last record will be
selected.
When using the arrow keys to navigate up
and down through the dataset, the cursor
will sometimes skip records.
The Advance Search in the QC screen is not
filtering data as it should.

Create a view with the
option "Consider family
relationships. Examine all
documents...". Enter QC
Console and manually
deactivate the item.
Discovery Cracker does not
produce TIFF images with
LZW compression during
normal rendering. However,
manual printing using the
DOX printers can cause this
incorrect compression of the
TIFF image. It is advised to
either render your
documents in Black and
White, or convert the
images to RGB Packbits
compression before
importing into Discovery
Cracker.
The Clear button on the
Advanced Search panel
clears the search results in
the Data Panel, not the
search criteria in the
Advanced Search panel.
You can change the criteria
by entering new values.
If this occurs, please contact
Product Support to report
the issue. To resolve the
issue, please close the DC
Console, QC Server, and
Workflow Manager to
release the session. Once
you reopen the components
and join the existing session,
you should be able to close
the session.
Check Worfkflow Manager
to see what item is currently
being used and do not
include locked items in your
selection grouping.
No known workaround at
this time.

QC

QC

Create a view prior to
performing QC.

Issue
Number
11876

11154

11288

11628

11685

11686

11730
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Affected Process

Description

Rendering

Discovery Cracker does not process the
correct number of pages if the setting
"Number Slides From" in PowerPoint is set
to start with “0".

Rendering

When rendering EML files with Outlook,
some of the e-mail header is missing.

Rendering

If an archive file contains documents with
foreign language characters in the file name
and the archive file is rendered with an OSassociated application, the corresponding
text file of the list of files inside the archive
does not contain the foreign language
characters.

Rendering

Reports

Reports

Reports

If you choose the setting to render
PowerPoint slides to a handout format
rather than a slide format, you have the
option to select the number of slides per
page in the handout. This setting is not
currently working and will only render 6
slides per page regardless of your chosen
settings.
The System Disk Usage Report is displaying
the disk usage of the local computer upon
which the report was run. When you are in
Discovery Cracker Console on one computer
and run the System Disk Usage Report for
a selected DC Engine computer, the report
displays the system disk information of your
Discovery Cracker Console computer.
The Problem Items report does not display
the full error message.

The report titled Summary Report of File
Counts by Status displays the previous
method of maintaining status which was to
use the individual tasks that an item would
go through during processing.

Workaround
If the settings are changed
to start from "1" in the
PowerPoint file, then
Discovery Cracker is able to
process the correct number
of pages.
If you change the rendering
application to the Discovery
Cracker Viewer, the entire
file header is included on the
TIFF image, but the section
will be shaded gray.
No known workaround at
this time.
You should make sure that
your archive application is
the most recent version to
handle creating the text file
correctly.
No known workaround at
this time.

Issue
Number
10491

10642

11161

11367

No known workaround at
this time.

10244

While the format of the
report displayed on the
screen does not display the
full error message, if you
export the report to an Excel
spreadsheet, you can expand
the error message column
and see the full error
message.
No known workaround at
this time.

10427

11190
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Affected Process
Security

Security

Security

Security

Settings

Description
The Can Export Click Robot Settings
function is enabled even though that
permission is cleared in the Manage
Security Roles and Permissions dialog box
(from Admin>Manage Security).
When the Can View Folder Setting
permission is selected in the Manage
Security Roles and Permissions dialog box
(from Admin>Manage Security), the option
to view folder settings is not available from
the right-click menu on a folder; however,
the option is available from the main menu
(View>Settings>Open Folder Settings).
When the Can Edit Views permission is
selected in the Manage Security Roles and
Permissions dialog box (from
Admin>Manage Security), the option to
edit views is not available from the main
menu (View>Settings>Open View
Settings) or the right-click menu.
Currently when you provide access to a user
for DC Detective, you see the project and
view icons and it appears that you can select
the view to provide permission without
giving permission to the entire project. This
is not accurate. You can only provide access
at the project level.
System Timeout Settings made from a
folder are not passed on to a project created
from the folder.

Settings

In the Folder Settings dialog box, the
Identify Scripts tab is not available for the
Metadata Extraction action.

Settings

When working with the Identify Scripts tab
of the Metadata Extraction action, if you
have previously saved a single field selection
for identification and decide to remove it,
the Save and Close button is not enabled.
When creating a separator template, and
any key is pressed in the Select a new
image field, an error occurs.
When creating a project-level filter and
using the option to consider the family
relationships for deactivation, if a document
is found to meet the criteria, the main item
is marked with a status of Inactive –
Filtered, but the child documents are not
being marked with the same status.

Settings

Status

Workaround
No known workaround at
this time.

Issue
Number
10223

No known workaround at
this time.

10224

No known workaround at
this time.

10225

No known workaround at
this time.

11189

Make sure to adjust any
timeout settings at the
system, project, or group
level if you need the setting
inherited to the next level.
The Identify Scripts tab is
available at the system,
project, group, view, and job
levels.
Add an additional field to
the selection and then
remove both fields at the
same time.

11388

Use the browse button
rather than typing the path
to the image.
No known workaround at
this time.

11465

11430

11432

11151
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Affected Process

Description

Workaround

User Interface

When selecting the rendering options for
Excel, you should not be allowed to select
both the Wrap text and the Shrink to fit
options at the same time. These two options
are mutually exclusive of one another.

User Interface

When creating a new document type group,
if you select the Tab key before entering a
document type group name, a red
exclamation warning will appear indicating
that you are missing the entry in this field.
Once this warning has been displayed, you
cannot continue with the process to add a
new document type group without first
closing and reopening the dialog box.
Cannot remove an image that was added
(without being saved) in the Add a
Reference File dialog box. Once it is added,
the image cannot be removed from within
the application.
When working with the Help screen open, if
you select a topic and browse down through
that topic, then you try to select any other
object on the Discovery Cracker Console,
the Help screen will reset itself back to the
Table of Contents.
Intermittently, when you select the refresh
button, all projects, groups, views, and jobs
disappear from the navigation pane.
If you mark a project as inactive, remove the
database from SQL Server, and then
reactivate the project in DC Console, you are
not warned that the database connection is
missing. From all appearances you can
create groups, views, or jobs. However, when
you attempt to do so, the hourglass appears
and never goes away.
If you detach a project database without
first marking a project as inactive in
Discovery Cracker Console, and then try to
open Discovery Cracker Console, you will
receive an error message: "Object reference
not set to an instance of an object."
Changing the name of a project causes an
error message. If you change the name of a
project after it has been created, an error
message will be displayed when you attempt
to save the changes.
If you attempt to create a project with
brackets [] in the project name, you will
receive an error message that states: SQL

Only select one of these
options. If the other option
is needed, first clear the
previously chosen option
before selecting the other
option.
Make sure to populate the
fields of the document type
group creation dialog box as
they appear on the screen.

User Interface

User Interface

User Interface

User Interface

User Interface

User Interface

User Interface

Issue
Number
10216

10232

No known workaround at
this time.

10235

No known workaround at
this time.

10290

Close Discovery Cracker
Console and reopen it.

10430

Before you reactivate a
project, make sure the
database is reattached to
SQL Server.

11128

Make sure that you
deactivate your project in
Discovery Cracker before
detaching it from SQL
Server.

11129

Do not change the name of
projects after they have
been created.

11146

Do not use brackets in the
project name.

11337
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Affected Process

User Interface

User Interface

Views

Description
2005 backward compatibility components
have not been installed.
When you export job settings from a project
that has a period in the project name and
then attempt to create a new job within any
project, you get the following error message:
“Index was outside the bounds of the array.”

Intermittently, when you select the Refresh
button, the project listings in the navigation
pane disappear.
When creating a Dynamic view, if a job is
running in the same project, the view is not
created and the Workflow Manager shuts
down.

Views

When creating a view that contains criteria
with an apostrophe, the view generates an
error.

Views

Dynamic views using the full-text search
functionality do not produce the same
results as the same view created as static.

Workflow
Manager

Intermittently, tasks are not sent to the DC
Engines and the following error is logged to
the manager database: "The Counter layout
for the Category specified is invalid."

Workaround

If you need to export your
job settings, do not use
periods in your project
names. If you receive this
error, delete any previously
exported job settings.
To do so, go to the JOBS
folder of the Reference Files
directory. Delete any .jex
files with that project name.
If this occurs, close
Discovery Cracker Console
and reopen it.
A dynamic view cannot be
created on a project when a
job is running. Create the
view before the job is run or
after it is complete.
Do not include apostrophes
in the criteria of a view
unless you have enabled
full-text indexing and use
the Phrase option when
creating the view criteria.
This is due to the indexing
that occurs with full-text
indexing. It is recommended
that you do not create
dynamic views when using
the full-fext search
functionality.
No known workaround at
this time.

Issue
Number

11458

11478

10464

11349

11575

11306
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